CANopen Design Tool
CANopen EDS Editor
User Manual

© port GmbH, Halle 2014/01/13; CANopen Design Tool Version 2.2.54
Disclaimer

All rights reserved

The programs, boards and documentations supplied by port GmbH are created with due diligence, checked carefully and tested on several applications.

Nevertheless, port GmbH can not take over no guarantee and no assume del credere liability that the program, the hardware board and the documentation are error-free respective are suitable to serve the special purpose.

In particular performance characteristics and technical data given in this document may not be constituted to be guaranteed product features in any legal sense.

For consequential damages, which are emerged on the strength of use the program and the hardware boards therefore, every legal responsibility or liability is excluded.

port has the right to modify the products described or their documentation at any time without prior warning, as long as these changes are made for reasons of reliability or technical improvement.

All rights of this documentation lie with port. The transfer of rights to third parties or duplication of this document in any form, whole or in part, is subject to written approval by port. Copies of this document may however be made exclusively for the use of the user and his engineers. The user is thereby responsible that third parties do not obtain access to these copies.

The soft- and hardware designations used are mostly registered and are subject to copy-right.

CANopen®
is registered trademark, licensed by CiA - CAN in Automation e.V., Germany.

EtherCAT®
is registered trademark and patented technology, licensed by Beckhoff Automation GmbH, Germany.

We are thankful for hints of possible errors and may ask around for an information.

We will go all the way to verify such hints fastest

Copyright

© 2014 port GmbH
Regensburger Straße 7
D-06132 Halle
Tel. +49 345 - 777 55 0
Fax. +49 345 - 777 55 20
E-Mail service@port.de
Internet http://www.port.de
# Table of Contents

1. Introduction .................................................. 7  
   1.1. Product Overview ........................................ 7  
   1.2. Product Delivery ......................................... 7  
   1.3. System requirements ..................................... 7  
   1.4. Installation ............................................. 8  
   1.5. Support by *port* ........................................ 8  

2. Usage of the CANopen Design Tool .......................... 9  
   2.1. Main menu ............................................... 9  
   2.2. Object tree ............................................ 10  
      2.2.1. Hardware configurations ........................... 10  
      2.2.2. Object dictionary .................................. 10  
   2.3. Action menus ........................................... 11  
   2.4. Forms ............................................... 12  
      2.4.1. General Settings ................................... 12  
      2.4.2. General EDS/ESI/XDD settings ..................... 13  
      2.4.3. Advanced configuration .............................. 13  
      2.4.4. Hardware configurations ............................ 14  
      2.4.5. Line specific EDS/XDD settings .................... 14  
      2.4.6. Line specific standard settings ................... 14  
      2.4.7. Additional CANopen Settings ....................... 14  
      2.4.8. Mask view ......................................... 14  
      2.4.9. Structure view ...................................... 14  
      2.4.10. Optimization view .................................. 17  
   2.5. Program control ....................................... 18  

3. File structure ............................................. 19  
   3.1. Project structure ...................................... 19  
      3.1.1. Project file ....................................... 19  
      3.1.2. Generated files .................................... 19  

---

Version: 2.2.54  CANopen Design Tool  Page 3 of 45
3.2. Profile files ........................................ 19
   3.2.1. Profile CiA-443: SIIS level-2 devices .......... 20

4. Project editing ........................................ 23
   4.1. Beginning a project .............................. 23
   4.2. Hardware configuration ........................... 23
   4.3. Application variables ............................. 24
      4.3.1. Parameterization of application variables .... 25
   4.4. Communication variables ........................... 25
      4.4.1. Parameterization .............................. 26
   4.5. Generation of source code ........................ 26
   4.6. %-Variables ...................................... 26
   4.7. {}-Expressions ................................... 27
   4.8. Post-Generation command ......................... 27

5. Special cases ........................................ 29
   5.1. Range checking for variables ...................... 29
   5.2. Grouping of indices in sub segments .............. 29
   5.3. Manufacturer structures (data types) ............. 29
   5.4. Predefined symbols ................................ 30
   5.5. Special names of object descriptions structures ... 30
   5.6. Non-standard extensions ........................... 30
   5.7. Limitations ....................................... 30

6. Generation of user-specific object descriptions .... 31
   6.1. Format descriptors ................................ 31
   6.2. Example for HTML documentation .................. 32
   6.3. Example for Tcl scripts ............................ 33

7. CAN-Merge PlugIn ..................................... 35
   7.1. Project View ..................................... 35
   7.2. Detail View ...................................... 36

8. CSV-Import PlugIn ................................. 37
8.1. Usage ........................................ 37
8.2. Examples ..................................... 38

9. Different versions ................................. 39
  9.1. Standard version ................................. 39
  9.2. Light version .................................. 39
    9.2.1. Limitations ................................. 39
    9.2.2. Usage .................................... 39
  9.3. CANopen EDS Editor ............................ 40
    9.3.1. Limitations ................................. 40
    9.3.2. Usage .................................... 40

10. How to convert existing projects .................... 41
  10.1. Existing projects - Version >= 2.2 .......... 41
  10.2. Existing projects - Version >= 2.0 .......... 41
  10.3. Existing projects - Version < 2.0 .......... 41
    10.3.1. The project converter ..................... 42
    10.3.2. Limitations ................................. 43
      10.3.2.1. Segmentation of the Object Dictionary .... 43
      10.3.2.2. User-defined data types ................ 43
    10.4. Conversion support .......................... 43
1. Introduction

1.1. Product Overview

The CANopen Design Tool of port is a software tool for the development of CANopen applications (devices). It manages device data bases from which an Object Dictionary, configuration and initialization files in C-code, an Electronic Data Sheet, a XML description and a HTML-documentation are created automatically. Furthermore the driver packages can be configured by the CANopen Design Tool and several hardware configurations can be managed within one project.

With the CANopen Design Tool an instrument is available which frees the developer of error-prone activities repeating itself. It ensures consistency of implemented functionality, Electronic Data Sheet (EDS/XDD) and device documentation. In the scope of delivery a data base with the CANopen communication profiles CiA-301 and CiA-302 are contained. Additionally the communication profile for safety-relevant communication CiA-304 is available. Profile databases are optionally available for various device profiles, for example digital I/O devices according to CiA-401 or drives according to CiA-402.

The created Object Dictionary supports numerous options of the CANopen library from port. Such as several CAN-lines (multiple lines) and segment structuring. A tree representation of all implemented parameters and data eases the maintenance of device software. With the CANopen Design Tool the beginning with the CANopen protocol is less difficult and the development of a device is accelerated.

1.2. Product Delivery

The scope of delivery of the CANopen Design Tool:

- User Manual
- software for CANopen Design Tool
- data bases for device profiles (optional)

All components are available for download.

This manual also covers the CANopen EDS Editor. For users of the CANopen EDS Editor some masks and generated files are not available. It is stated in each section of the manual if the information is applicable only for the CANopen Design Tool or also for the CANopen EDS Editor.

1.3. System requirements

The CANopen Design Tool runs on PC’s with Microsoft Windows™ or Linux.

Processor: Pentium IV or later
RAM: 512 MByte
1.4. Installation

The installation is controlled by menus. For this purpose, unpack the zip-file and start setup.exe on Windows™ resp. setup.sh on Linux. After this installation you will find the following directory structure.

![Directory structure of the CANopen Design Tool](image)

Figure 1, Directory structure of the CANopen Design Tool

The directory **projects** contains delivered example projects. For each project a separate directory is recommended. The data bases are in the directory **profiles** for the communication profiles DS 301, DS 302 and the CANopen device profiles. In this directory own profiles can also be generated. The directory **help** serves internal purposes.

After an installation on a Windows™ system the CANopen Design Tool can be started by the icon on the desktop or via the start menu.

1.5. Support by port

The senior engineers at port support the user by a telephone hot-line and by training courses. Additionally the user can have consultations in the whole field of CAN e.g. network planning, network configuration, message distribution, selection of devices and CANopen Profile implementations.

Please ask at our email address

E-mail: service@port.de

phone: +49 345 777 55 - 0

Fax: +49 345 777 55 - 20

The engineers at port react as soon as possible to your message.
2. Usage of the CANopen Design Tool
The CANopen Design Tool is controlled via menus, toolbars, treeviews and masks.

2.1. Main menu
The Main menu consists of the following entries:

File
Via the menu option File the projects are created, loaded and closed. Further, in this menu the program can be terminated.

Edit
The menu options below Edit are meant to copy, cut or paste objects in the object dictionary.

Generate
By selecting the menu option Generate all Files within the menu Generate the Object Dictionary, electronic device description, the initialization file co_init.c and the configuration file cal_conf.h is generated. If Generate Documentation is selected, the documentation in HTML and as plain text will be generated.

Show
Via the menu option Show all the generated files can be viewed. The HTML Documentation is displayed with the standard browser.

Options
The Options menu organizes the options for the following:
• Generation of electronic device descriptions
• View of the Object Dictionary tree with EDS names or variable names
• Choice of standard or special names for object description structures
• Default selection of mask or structure view for objects.
• Object description structures
• object.c generation
• Font configuration
View options are saved user-specific in the registry (or in a.rc file under Linux) and generation options are saved project-specific in the project file.

Help
In the Help menu the help for the current mask or the manual can be viewed. It is shown in the standard browser.

Figure 2, Toolbar
The toolbar below the menu provides a fast access to the following functions: new project, open, save, cut, copy, paste, generate, add new service objects and query new releases.
2.2. Object tree

The object tree is central administrative element for all CANopen entities as well as all further device parameters and for the hardware configurations. It consists of branches for the global device parameters, branches for the hardware configurations, advanced settings, and branches for the supported lines\(^1\). The global ESI/EDS resp. XDD parameters are parameters such as manufacturer name and product designation which are identical for every CAN line. The general settings and the general optimization settings are meant to set defines in the file cal_conf.h to configure the CANopen library. See the manual of the library for further information.

The individual line entries are split into:
- EDS/XDD\(^2\) settings
- Standard settings (Kind of node and optimization)
- Additional CANopen Settings
- Object dictionary

2.2.1. Hardware configurations

The CANopen Design Tool can manage several hardware configurations. A hardware configuration consists of:
- Debug Settings
  Configuration of debug messages
- CPU Settings
  Choice and configuration of the CPU or the operating system
- Compiler Settings
  Choice and configuration of the used compiler
- CAN Settings
  Choice and configuration of the used CAN controller or CAN-interface card (one CAN configuration per CAN line)

By setting the hardware configuration, defines in the file cal_conf.h are set that configure the Driver Package.

2.2.2. Object dictionary

The object dictionary is divided into different branches for the separate segments.
- data types (Indices 0001\(_h\) − 025F\(_h\))
- communication data (Indices 1000\(_h\) − 1FFF\(_h\))
- manufacturer specific data (Indices 2000\(_h\) − 5FFF\(_h\))
- standardized device profile segment data (Indices 6000\(_h\) − 9FFF\(_h\) in blocks of 800\(_h\))
- range for DS 405 devices (Indices A000\(_h\) − AFFF\(_h\))

---

\(^1\) A standard CANopen device only supports one CAN line. The multi line option is a special feature of the company port for implementation of gateway nodes.

\(^2\) XDD ... XML Device Description (modern EDS replacement)
• reserved area $B000_{h} – FFFF_{h}$

The division of the area for standardized device profiles into blocks of $800_{h}$ was carried out under special regard to the multi device profile. Operations, as doubling identical segments, can be implemented simply by the representation of every device profile as a separate segment. Further, the arrangement of identical segments is possible within the Object Dictionary by means of a C-structure by allocation of a common variable name. That has special advantages for variable access within the device. For example in multi axis devices by switching to another axis with an array index. This segmentation is also possible for the vendor-specific data. With these, the start of the 1st block as well as the size of the blocks can be parameterized freely. A separation of vendor-specific and device profile specific blocks is possible if these ones have identical structure.

The individual branches of the object dictionary contain the CANopen objects. These entities are in turn divided into their sub-index elements.

On activation of the individual components in the tree, action menus are displayed in the right frame. e.g. for the data import or the accordant object forms.

### 2.3. Action menus

The action menus differ for every branch of the object tree. Menus are available for:

• operations for the hardware settings
• operations referring to one CAN line
• operations referring to the object dictionary
• operations referring to communication parameters
• operations referring to manufacturer specific parameters
• operations referring to device profile parameters

Hardware configuration can be:

• added,
• copied,
• deleted,
• imported and exported.

One can execute for the individual CAN lines:

• adding a new line
• deleting the whole CAN line

For the object dictionary the following actions are available:

• data import from profile files
• data import from an EDS or XDD file
• data export to profile files

One can execute for the segment with communication parameters:

• data import from files (profile or EDS/XDD)
• data export to profile files
• creating of new objects (indices)
• creating of new communication service objects
The vendor-specific segment has action buttons for:
• data import from files (profile or EDS/XDD)
• data export to profile files
• creating new objects (indices)
• creating of a new sub segment
For the device profile segment the following actions are possible:
• data import from files (profile or EDS/XDD)
• data export to profile files
• creating new objects (indices)
• creating of a sub segment
For sub segments the following actions are available:
• data import from files (profile or EDS/XDD)
• data export to profile files
• creating new objects (indices)
• configuration of the sub segment

2.4. Forms
Forms and input masks simplify the data input. Additionally to the following documentation there is an online help for each mask available about <F1>.

2.4.1. General Settings
The general settings are meant to define global device settings. With these settings the CANopen library is configured with the help of the file cal_conf.h.
The default values are adequate for a CANopen Slave device. Each setting is explained in the context help, which can be opened by pressing F1 or at the menu "Help -> Context Help".

**2.4.2. General EDS/ESI/XDD settings**

The global EDS/ESI/XDD form is used for processing all device global entities, that are device, manufacturer and ordering data.

**2.4.3. Advanced configuration**

This mask provides access to special user defines in the configuration file `cal_conf.h`. This file is included in all CANopen-files and should be included in every CANopen-related project file. So compiler directives changed here, will affect the whole project. Please enter valid C code like e.g.

```c
#define CONFIG_BIG_RAM_VERSION 1
```
/* undefine printf */
#define PRINTF
Be carefully with these settings.

2.4.4. Hardware configurations
A hardware configuration can be renamed, duplicated, deleted, imported and exported by its action menu. The active configuration is marked with a pair of asterisks (*) in the project tree. The sub sections Debug Settings, CPU Settings and Compiler Settings are valid for the whole configuration but the CAN Settings are specific for each CAN line.
The parameters of the sub sections are explained in the context help for each mask.

2.4.5. Line specific EDS/XDD settings
With the line EDS/XDD form characteristics of the device can be described, but some of them can only be stored in the XDD file. A comment which is saved in the EDS file can be input additionally.

2.4.6. Line specific standard settings
The choice whether this line works as a Slave or a Master has to be set here. Furthermore, global defaults for the optimization of each object > 2000$^h$ are set here. The most usual case, that each variable should be created and that the description structure of each variable is constant, is set by default. Detailed information on each parameter can be found at the context help of the optimization tab at an index. Please regard that the settings for the object will only be updated, if the settings in this mask are changed. E.g. 'Create Variable’ is set for all objects but for one object it is deactivated manually. If you want to set 'Create Variable’ for all objects again, you have to deselect it and leave this form and re-enter and reset it again. Now at all objects 'Create Variable’ is set again.

2.4.7. Additional CANopen Settings
The additional CANopen settings are meant to configure additional CANopen services that are beyond the normal library services. Please have a look into the library’s manual and into the context help for further information.

2.4.8. Mask view
These forms are a wizard for the communication parameters. In this way, the input of the parameters is facilitated since the bit values coded are converted into text outputs. Contiguous entities are also parameterized transparently for the operator. Please regard that the mask view is only available for some objects.

2.4.9. Structure view
The structure view is the universal editor with that all entity parameters can be changed. It is distinguished into a view for the index parameters and one for the sub-index parameters.
<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Index</td>
<td>Number of index (hexadecimal)</td>
</tr>
<tr>
<td>Name</td>
<td>Name of global C variable</td>
</tr>
<tr>
<td>Data Type</td>
<td>data type according to CANopen</td>
</tr>
<tr>
<td>Object Code</td>
<td>Kind of object according to CANopen specification:</td>
</tr>
<tr>
<td></td>
<td>allowed values: Variable, Array, Record, Domain</td>
</tr>
<tr>
<td>Object name</td>
<td>name of the object in XDD/EDS/ESI file</td>
</tr>
<tr>
<td>Description</td>
<td>description of the object for the documentation and for the parameter description in XDD files</td>
</tr>
</tbody>
</table>

**Table 1.** Elements of the structure view for indices

The data type and the object code are fixed for communication objects in the object range \(1000_{16}\) to \(1FFF_{16}\) to be compliant to the specification.
<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
<th>Lib</th>
<th>EDS</th>
<th>XDD</th>
<th>Doc</th>
</tr>
</thead>
<tbody>
<tr>
<td>Index</td>
<td>Number of index (hexadecimal)</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td>Sub-Index</td>
<td>number of sub-index (decimal)</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td>PDO-Mapping</td>
<td>if selected, the object can be mapped to a PDO</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td>EDS-Name</td>
<td>EDS name for sub-index (only relevant to arrays and records)</td>
<td></td>
<td>x</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td>Unit</td>
<td>measurement unit of the object</td>
<td></td>
<td></td>
<td></td>
<td>x</td>
</tr>
<tr>
<td>Access</td>
<td>access permissions seen from CAN</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td>Data Type</td>
<td>type of object</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td>Size</td>
<td>size of object in Bytes</td>
<td></td>
<td></td>
<td></td>
<td>x</td>
</tr>
<tr>
<td>Value</td>
<td>default value of the variable</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td>Lower Limit</td>
<td>lower limit for numerical values</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td>Upper Limit</td>
<td>upper limit for numerical values</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td>DefaultValue in EDS*</td>
<td>Write default value to EDS file</td>
<td>x</td>
<td>x</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Limits in EDS*</td>
<td>Write limit to EDS file</td>
<td></td>
<td>x</td>
<td>x</td>
<td></td>
</tr>
<tr>
<td>Refuse read on scan*</td>
<td>Corresponding ObjFlags setting in EDS/XDD files</td>
<td></td>
<td>x</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Refuse write on down-load*</td>
<td>Corresponding ObjFlags setting in EDS/XDD files</td>
<td></td>
<td>x</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Valid after reset*</td>
<td>Corresponding ObjFlags setting in XDD files</td>
<td></td>
<td></td>
<td></td>
<td>x</td>
</tr>
</tbody>
</table>

**Table 2.** Elements of the structure view for Sub indices

All items marked with an asterik (*) are rarely used and can be hidden via "Options → View Options → Hide EDS/XDD flags".

Within the *Object Name* and *Name* entries internal %-variables can be used. They will be replaced with their current value at generation. E.g. %s stores the value of the current sub-index and an XDD name like "Output %s" will be replaced with "Output 0", "Output 1" ... or "Output 254". With these substitutions it becomes much more easier to copy or duplicate objects. All %-variables are described in section %-variables in chapter 4.7.
2.4.10. Optimization view

The optimization view provides access to the optimization parameter of the objects. These optimizations only affect the generated C and H files.

**Storage Class**

defines the storage class of the object. Valid values depend on the compiler.

**Create Variable**

If this is set, the variable will be created. Otherwise it is declared as extern in the file `objects.h`, if `create extern declaration` is set.

**Same Structure for all Subs**

By setting this option, the 'Short Description' Parameter will be set in the variable’s description structure. (only relevant for arrays)

**Constant Value Description Structure**

This declares the description structure as constant. If it changes during run time, the structure may not be constant.

**Virtual Object**

If an object is marked as virtual object, it will not appear in `objects.h`, but in the documentation and in the EDS. This attribute is only available for objects within the

---

**Figure 4**, structure view of an object

<table>
<thead>
<tr>
<th>Mask</th>
<th>Structure</th>
<th>Optimization</th>
</tr>
</thead>
</table>

| Index: | 1600 |
| Name: | p301_n%pdo_para |

| Data Type: | PDO_CCMN_PAR | Object Code: | Record |
| EDG Name: | Transmit PDO Communication Parameter %f |

**Description:**

It contains the communication parameters of the current PDO the device is able to transmit.

- Sub-index 0 contains the number of PDO-parameters implemented.
- Sub index 1 describes the COB-ID. If bit 31 is set the PDO is disabled.
- The transmission mode is defined by sub-index 2.
- An inhibit time can be defined on sub-index 3 in 100 us.
- At the 5th sub-index an event time for asynchronous PDoS can be defined.
manufacturer specific segment or the device profile segment.

**Create Type Definition**
This attribute is only available at user-defined data types and enables the type definition for this data type in the file `objects.h`.

**Constant default value**
By setting this attribute the default value of this object will be stored in a constant array.

**Constant limits**
By setting this attribute the limits of this object will be stored in a constant array.

Limits and default values are mostly constant. Variable default values and limits will need a lot more memory. These settings have no effect on strings or domains.

![Object 6000 - Optimization](image)

**Figure 5.** optimization view of an object

**2.5. Program control**
The operation of the entire program is done mostly with the mouse. Changed values are taken over only at leaving of the mask. E.g. continuous actions such as computation of new sizes during type variation.

Modifications at a mask can be reset before the mask has been left by pressing the button "Reset". If default values are available for a mask, these values can be loaded by the button "Default".
3. File structure

3.1. Project structure

3.1.1. Project file

All data of an project are stored in the project file. Nevertheless it is useful to have a directory for every project, because the generated files will be stored in the project directory.

The directory ’projects’ under the program directory contains some example projects.

3.1.2. Generated files

The generated files are described in table 3.

<table>
<thead>
<tr>
<th>File</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>objects.h</td>
<td>Object dictionary implementation (C code)</td>
</tr>
<tr>
<td>objects.c</td>
<td>Object dictionary implementation (C code) (optional)</td>
</tr>
<tr>
<td>cal_conf.h</td>
<td>configuration file for the library (C code)</td>
</tr>
<tr>
<td>co_init.c</td>
<td>initialization file for the library (C code)</td>
</tr>
<tr>
<td>&lt;edsFileName&gt;.eds</td>
<td>generated EDS file for a CAN line</td>
</tr>
<tr>
<td>&lt;edsFileName&gt;.txt</td>
<td>description file for the CANopen Device Monitor</td>
</tr>
<tr>
<td>&lt;edsFileName&gt;.xdd</td>
<td>generated XDD file for a CAN line in XML format</td>
</tr>
<tr>
<td>&lt;projectName&gt;_docu.txt</td>
<td>documentation as text for implemented objects</td>
</tr>
<tr>
<td>userList.txt</td>
<td>user-specific object description (optional)</td>
</tr>
<tr>
<td>generate.err</td>
<td>information file that contains error and warning mes-</td>
</tr>
<tr>
<td></td>
<td>sages</td>
</tr>
</tbody>
</table>

Table 3, Generated files

The CANopen EDS Editor generates the XDD file, the EDS file and as well the documentation of the object dictionary. C source code is not generated by the CANopen EDS Editor.

After generation the files, the object dictionary for the CANopen source library and a documentation are available. If errors occurred, the files have not been generated and the errors are listed in generate.err

3.2. Profile files

Profile files contain parts of an object dictionary with the objects and their attributes. The CANopen Design Tool is delivered with a profile, that contains all communication
objects according to the communication profiles. If communication objects are set up with the CANopen Design Tool, the entries will be loaded automatically from this profile. Additionally to the communication object data base, profile files for other CANopen device profiles are available from port. By means of these profiles standard applications can be implemented in shortest time.

For demonstration purpose some device profile data bases are delivered with the CANopen Design Tool. Objects from such a device profile data base can be imported, but without a valid license for this data base the output cannot be created. To order a license for a device profile please contact service@port.de.

If parts of a project are to be used in later projects, the data can be exported into a separate file.

### 3.2.1. Profile CiA-443: SIIS level-2 devices

profile database file: profile443_v2_1_0.pro
availability: licence necessary
reference to CiA standard: CiA-443, V2.1.0

The profile database for the CiA-443 provides the profile-specific data types and objects with except for object 6010h (p443_cpu_clock_time_and_date).

The profile-specific data types are dependent on the number of channels or valves which can be different for various objects. The Design Tool generates special C structures for the sub-indices which are depending on channels or valves to provide an effective access on the objects in C code. All structure definitions are stored in the generated file objects.h.

Example: data type 0082h (12-CHANNEL METAL LOSS)

The data type is compound by general and channel-dependent sub-indices. The following C structure for the channel-dependent sub-indices is generated:

```c
typedef struct {
    UNSIGNED8 status; /**< channel status */
    REAL32 averageMetalLoss; /**< channel average metal loss */
    REAL32 averageTemperature; /**< channel average temperature */
    REAL32 sector_1_metalLoss; /**< channel sector 1 metal loss */
    REAL32 sector_1_temperature; /**< channel sector 1 temperature */
    REAL32 sector_2_metalLoss; /**< channel sector 2 metal loss */
    REAL32 sector_2_temperature; /**< channel sector 2 temperature */
    REAL32 sector_3_metalLoss; /**< channel sector 3 metal loss */
    REAL32 sector_3_temperature; /**< channel sector 3 temperature */
    REAL32 sector_4_metalLoss; /**< channel sector 4 metal loss */
    REAL32 sector_4_temperature; /**< channel sector 4 temperature */
    REAL32 sector_5_metalLoss; /**< channel sector 5 metal loss */
    REAL32 sector_5_temperature; /**< channel sector 5 temperature */
```
REAL32 sector_6_metalLoss; /**< channel sector 6 metal loss */
REAL32 sector_6_temperature; /**< channel sector 6 temperature */
REAL32 sector_7_metalLoss; /**< channel sector 7 metal loss */
REAL32 sector_7_temperature; /**< channel sector 7 temperature */
REAL32 sector_8_metalLoss; /**< channel sector 8 metal loss */
REAL32 sector_8_temperature; /**< channel sector 8 temperature */
} P443_CHANNEL_METAL_LOSS_T;

The C structure for data type 0082 with 2 channels is:
typedef struct {
    UNSIGNED8 numOfEntries; /**< number of entries */
    UNSIGNED32 siUnitMetalLoss; /**< SI unit for metal loss */
    UNSIGNED32 siUnitTemperature; /**< SI unit for temperature */
    P443_CHANNEL_METAL_LOSS_T chan[2]; /**< channels */
} P443_12_CHANNEL_METAL_LOSS_2_T;

The condition for the generation of channel-dependent data types is the setting of the profile number in object 1000h (p301_device_type) or in object 67FFh (single_device_type) for multiple logical devices.
The names of the C structure elements are fixed.
The C names of the P443 objects on Tab Structure for the Main Index have to be modified by a repeated import without usage of segmentation.
4. Project editing
This chapter describes the working flow for creating and editing projects. The order of
the flow is not mandatory, but very useful. Basic parameter like the number of CAN lines
and the kind of the device (Slave or Master) should be clear at the beginning of the devel-
opment. The necessary steps are the following:

• configuration of global parameter
• configuration of global ESI resp. EDS parameter
• configuration of the hardware settings
• configuration of CAN line specific EDS parameter
• configuration of standard and additional settings
• definition of application variables
• parameterization of application variables
• definition of communication variables
• parameterization of communication variables
• optimization of each object if needed
• generation of outputs

4.1. Beginning a project
A project is created by the menu File → New Project.
Existing projects are opened by the button Open Project or the menu File.
Each CAN line can be preset with data from a profile or an EDS file.

4.2. Hardware configuration
At first the target hardware has to be configured. The most important decision is to
choose a CPU resp. an operating system.
Default configurations for the supported platforms can be found at the s1-example of the
CANopen-library. These configuration files (conf_xxxx.h) can be imported via
"Import Configuration".

![Figure 6, hardware configuration part of the project tree](image)
If the CPU is set, the other CPU settings are set to CPU-specific default values. These default values are suitable in the majority of cases. At Compiler Settings the used compiler can be selected. For each line the CAN-controller or the PC-CAN-Interface must be configured. This can be done at CAN Settings. There the CAN controller family must be chosen at first and then the particular CAN controller type can be set. Detailed information about each attribute at these form can be found at the context help.

If the application shall be used on different hardware platforms, more than one hardware configuration can be created. If no configuration is marked as active, the define CONFIG_USE_TARGET_x must be set to 1 in the makefile or in the compiler.

4.3. Application variables

Definition of application variables is the creation of objects with indices in the range of 2000$_h$ – 5FFF$_h$ for manufacturer specific profiles or in the range of 6000$_h$ – 9FFF$_h$ for standardized device profile objects. There are two ways for the definition:

- loading from a profile
- creation by hand

The first way is easier. Certain objects can be selected by means of their index from a profile. Databases for the standardized CANopen device profiles are available from port. If a database doesn’t exist yet, all entries can be created by hand. It is distinguished in parameter for the index and for parameter describing the sub-index.

The index parameter defines the structure of the variable. That means their type, kind (Variable, Array, Record, Domain), the number of sub-indices, the C variable name and an object name. Furthermore the variable can be commented. This comment will be a part of the documentation for this object. The parameters for sub-indices contain an object name for record or array members, size and type and access permissions. For each a unit can be assigned. If application-specific data types for records are used, they have to be defined in the data type section of the object directory in advance of their usage.
4.3.1. Parameterization of application variables

The parameterization of application variables is done in the structure view for the sub-index elements.

4.4. Communication variables

For definition of communication variables the same mechanism is possible as described for the application variables. Additionally the necessary data are loaded from the communication object database. That means, the structure of the created variables is already defined and all parameter entries are preset. For CANopen conform devices one has to define at least the objects:

- Device Type (1000h)
- Identity Object (1018h)
- and more.

The CANopen standard requires these objects.

There are special menus for the creation of communication parameter. These can be reached via the button Add new Communication Service in the action menu of the Communication Segment.
**Figure 8**, dialog to create new communication services

For each CANopen service e.g. PDOs these menus are prepared. On this menus the user has only to make design decisions. No knowledge about the encoding and the contexts between communication objects is necessary.

**4.4.1. Parameterization**

For parameterization of communication variables the mask view can be used. With these forms the parameterization of more complex data like PDO parameter and PDO mapping is very easy.

**4.5. Generation of source code**

When the button *Generate* is pressed the object dictionary implementation in C-code the initialization and configuration files and furthermore an EDS resp. ESI file for each CAN line (*<ProjectName>line<lineNo>.eds*) and if activated a documentation (*<project name>.html*) are generated. These files are always consistent and contain the date and the time of generation. Another file (*generate.err*) contains warnings and errors. It is recommended, to have a look to this file by means of *Show* after each generation.

**4.6. %-Variables**

%-variables can be used in object names and variable names of indices and object names of sub-indices. In the file *objects.c*, in the EDS files and in the documentation and also in the object tree they are replaced by their current values.
<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>%i</td>
<td>number of the index</td>
</tr>
<tr>
<td>%s</td>
<td>number of the sub-index</td>
</tr>
<tr>
<td>%l</td>
<td>number of the line</td>
</tr>
<tr>
<td>%f</td>
<td>number of the service (SSDO, CSDO, RPDO, RPDO-Mapping, TPDO-Mapping, SRDO, SRDO-Mapping) starting at 1</td>
</tr>
<tr>
<td>%p</td>
<td>(index - start of segment) starting at 0</td>
</tr>
<tr>
<td>%q</td>
<td>(index - start of segment + 1) starting at 1</td>
</tr>
<tr>
<td>%u</td>
<td>(index - start of sub segment) starting at 0</td>
</tr>
<tr>
<td>%v</td>
<td>(index - start of sub segment + 1) starting at 1</td>
</tr>
<tr>
<td>%t</td>
<td>short name of data type</td>
</tr>
</tbody>
</table>

Table 5, %-variables

When using lower case letters for the variables a decimal value is returned. Otherwise a hexadecimal value without leading "0x". Variables that are undefined in the current context (e.g. %s at an index) return an empty string.

Examples für the usage of these %-variables can be found at the SDO or PDO objects in the communication profile.

4.7. {}-Expressions

The {}-expressions allow the usage of %-variables and mathematical operators. Inside of the braces %-variables, constants (decimal/hexadecimal) and the operators + - * and / can be used.

Examples for valid object names with {}-expressions:
- output {%i - 0x100}
- state {%p + 100} at device %l

4.8. Post-Generation command

At Generation → Post-Generation Settings the post-generation command can be configured. The post-generation command is executed after the generation of the output files. The command may be a shell-script or a batch file, or you may run e.g. `make all` or start an arbitrary executable file (e.g. the EDS checker or your compiler). The output of the command is written into the file generate.err.
5. Special cases
This chapter describes some special cases for object dictionary generation. The CANopen Design Tool supports the generation of object dictionary implementations for the 'single'-line release and the 'multiple'-line release of the CANopen library of port. The following special cases are used for the optimization of the implementation.

5.1. Range checking for variables
Entries are set up as a default during generation of the object dictionary for minimum and maximum values. These limit values are used of the CANopen library by port during SDO transfer for limit supervision. The limit monitoring can be switched on/off via object 1200h / tab Mask / checkbox "Check Object Limits with SDO Transfer". This setting activates or deactivates the compiler define CONFIG_LIMITS_CHECK.

5.2. Grouping of indices in sub segments
A further characteristic is the organization of device variables within structures. Such an organization is possible for the manufacturer data and for data of the standardized device profiles. This is convenient if identical entries in the individual sub segments are stored. If the data of two sub segments should be filled in a structure, the sub segments should share the same variable name and the same length. Useful steps for this are:
- Creation of the sub segment (Add new Sub Segment)
- Filling with objects
- Duplication of the sub segment (Duplicate)

Result of this grouping is a structure and a C-array of the type of this structure. The array has as many elements as group members (sub segments with same variable name) are available. The advantage of such an organization is that the indexed addressing of the C-arrays can be used. E.g. with multi axis drives for fast access with pointer switching in firmware between the individual axes.

The same principle is pursued for manufacturer data. However, it is possible to select a starting index for the segment and to declare the segment size freely. That means that the data is stored normally up to the user defined index. From this index on the tree becomes segmented in the manufacturer specific area.

5.3. Manufacturer structures (data types)
To use records with own structures (data types) in the manufacturer specific segment, these data types have to be defined first in the 'Data Types' section of the line. Therefore a new index can be added by 'Add new Data Type'. According to the standard the index should be between 0040h and 005Fh and its object code has to be 'DefStruct'. It is recommended to use the same name for 'name' and 'EDS name'. The name, e.g. 'MYTYPE_T' is used in the file objects.h and there the new data type is declared, too. After that the needed structure elements can be added by 'Add new Sub Index'. Each of them needs further a data type and a name. The names have to be valid C variable names.
All other entries at this mask are deactivated and can be ignored. If the data type is created successfully, it can be used for indices starting at 2000 with the object code 'Record'.

5.4. Predefined symbols
Predefined preprocessor symbols like __DATE__, __TIME__, __FILE__ etc. can be used within strings, but you have to put quotes around.

5.5. Special names of object descriptions structures
If Options → View Options → Use special description structures is activated, the name for the description structure is derived from the index of the object but not from the name of the object.

5.6. Non-standard extensions
Normally, the CANopen Stack sets the COB-IDs of PDOs and SDOs after the start of the CANopen application according to the 'Predefined Connection Set'. If Options → Generate Options → Enable non-standard extensions is activated, an additional function is created in the file co_init.c. This function overwrites the 'Predefined Connection Set'. Additionally, the COB-IDs defined in the CANopen Design Tool are written to the EDS file.

! This is not compliant to the CANopen specification !

5.7. Limitations
The optimization configured at the optimization tab of an index can only be used outside of sub segments. The reason for this is, that sub segments are stored in C-structures and it is not possible to assign a storage class to a single member of a structure.
6. Generation of user-specific object descriptions

The Design Tool provides format descriptors for the generation of user-specific object descriptions in ASCII-format for different document types.

The description template is a text in ASCII-Format including format descriptors for object-specific information and has to be stored in file list.conf in the working directory. During the generation of all files the description template is applied to each object. The Design Tool stores the object list in the file userList.txt in the working directory.

6.1. Format descriptors

The Design Tool supports the following format descriptors:

<table>
<thead>
<tr>
<th>format descriptor</th>
<th>description</th>
</tr>
</thead>
<tbody>
<tr>
<td>%a</td>
<td>access type: RO, WO, RW, RWW, RWR, CONST</td>
</tr>
<tr>
<td>%D</td>
<td>refuses write on download: 0 - not valid, 1 - valid</td>
</tr>
<tr>
<td>%d</td>
<td>data type according to CiA-309-3 (example: u32)</td>
</tr>
<tr>
<td>%e</td>
<td>EDS name of the object index</td>
</tr>
<tr>
<td>%F</td>
<td>default value in EDS valid: 0 - not valid, 1 - valid</td>
</tr>
<tr>
<td>%g</td>
<td>size in bytes in decimal format (example: 12)</td>
</tr>
<tr>
<td>%I</td>
<td>object index in hexadecimal format without prefix (example: 1A00)</td>
</tr>
<tr>
<td>%i</td>
<td>object index in decimal format (example: 4096)</td>
</tr>
<tr>
<td>%L</td>
<td>line number in hexadecimal format without prefix (example: A)</td>
</tr>
<tr>
<td>%l</td>
<td>line number in decimal format (example: 12)</td>
</tr>
<tr>
<td>%M</td>
<td>limits in EDS valid: 0 - not valid, 1 - valid</td>
</tr>
<tr>
<td>%m</td>
<td>lower (minimum) limit</td>
</tr>
<tr>
<td></td>
<td>• for numerical objects: in hexadecimal format with prefix &quot;0x&quot;</td>
</tr>
<tr>
<td></td>
<td>(example: 0xFFFFFFFF)</td>
</tr>
<tr>
<td></td>
<td>• for string objects: &lt;empty string&gt;</td>
</tr>
<tr>
<td>%n</td>
<td>name of the object index in C code</td>
</tr>
<tr>
<td>%p</td>
<td>PDO mapping allowed: 0 - not valid, 1 - valid</td>
</tr>
<tr>
<td>%O</td>
<td>refuses Read on scan: 0 - not valid, 1 - valid</td>
</tr>
<tr>
<td>%R</td>
<td>valid after reset: 0 - not valid, 1 - valid</td>
</tr>
<tr>
<td>%S</td>
<td>sub-index in hexadecimal format without prefix (example: A)</td>
</tr>
<tr>
<td>%s</td>
<td>sub-index in decimal format (example: 12)</td>
</tr>
<tr>
<td>%T</td>
<td>description of the object</td>
</tr>
</tbody>
</table>

Take note that the Design Tool can not convert special characters because it does not know the desired document type.
<table>
<thead>
<tr>
<th>format descriptor</th>
<th>description</th>
</tr>
</thead>
</table>
| %U               | upper limit  
  • for numerical objects: in hexadecimal format with prefix "0x"  
    (example: 0xFFFFFFFF)  
  • for string objects: <empty string> |
| %u               | unit (example: 100 ms) |
| %V               | default value  
  • for numerical objects: in hexadecimal format with prefix "0x"  
    (example: 0xFFFFFFFF)  
  • for string objects: without quotation tags  
    (example: Test string) |
| %v               | default value  
  • for numerical objects: in decimal format  
    (example: 1614872592)  
  • for string objects: without quotation tags  
    (example: Test string) |
| %z               | enumeration counter of the object in decimal format, counting starts with 0  
    (example: 12, i.e. it is the 12th object) |

Table 6, format descriptors

6.2. Example for HTML documentation

Each object in the object dictionary is listed with index, sub-index in bold text style and the object description. The following example only refers to object 1000h and 1001h.

`list.conf:`

```xml
<p>
  <b> object %Ih/%S </b>: %T
</p>
```

`userList.txt:`

```xml
<p>
  <b> object 1000h/0 </b>: The device type specifies the kind of device. The lower 16 bit contain the device profile number and the upper 16 bit an additional information.
</p>

<p> <b> object 1001h/0 </b>: The error register is a field of 8 bits, each for a certain error type. If an error occurs the bit has to be set: Bit 0 generic error, Bit 1 current, Bit 2 voltage, Bit 3 temperature, Bit 4 communication error (overrun, error state), Bit 5 device profile specific, Bit 6 reserved, Bit 7 manufacturer specific 
</p>

```
indication in the web-browser:

**object 1000h/0:** The device type specifies the kind of device. The lower 16 bit contain the device profile number and the upper 16 bit an additional information.

**object 1001h/0:** The error register is a field of 8 bits, each for a certain error type. If an error occurs the bit has to be set: Bit 0 generic error, Bit 1 current, Bit 2 voltage, Bit 3 temperature, Bit 4 communication error (overrun, error state), Bit 5 device profile specific, Bit 6 reserved, Bit 7 manufacturer specific

### 6.3. Example for Tcl scripts

A list of all objects is created. The entry for each object starts with a comment including the enumeration counter. The enumeration counter is also used as list index for the list **objTab.** The index, sub-index and the default value are listed for each object. The following example only refers to object 1000h and 1001h.

**list.conf:**

```tcl
#object %z
set objNum %z
set objTab($objNum,indexHex) 0x%I
set objTab($objNum,subHex) %S
set objTab($objNum,defValHex) "%V"
```

**userList.txt:**

```tcl
#object 0
set objNum 0
set objTab($objNum,indexHex) 0x1000
set objTab($objNum,subHex) 0
set objTab($objNum,defValHex) "0x00000000"

#object 1
set objNum 1
set objTab($objNum,indexHex) 0x1001
set objTab($objNum,subHex) 0
set objTab($objNum,defValHex) "0x00"
```

The generated object list can be used after sourcing in a Tcl scripts - especially in the frame for testing in the Console of the CANopen Device Monitor.
7. CAN-Merge PlugIn

CAN-Merge provides functions to visualize and modify differences between different CANopen Design Tool projects. The CAN-Merge extension module is an optional Plug-In which is activated by the license file of the CANopen Design Tool. If a valid license is present, CAN-Merge can be started by the CAN-Merge menu in the menu bar of the CANopen Design Tool.

![Figure 9, CAN-Merge main window displaying 2 projects](image)

7.1. Project View

The project view shows different settings, sub segments, objects and sub indices with different colors. By using the Merge function in the tool bar these elements can be copied from one project into the other one.

Via the menu File the modified projects can be saved to disk or imported into the CANopen Design Tool. The menu entries like Save resp. Open refer to the active project tree. Via Generate Diff Report an overview about the differences between the projects can be generated. This diff report is an XML file containing all differences.

Via Options several settings can be configured. These include the attributes to be compared or merged and further options.
7.2. Detail View

![Figure 10](image)

**Figure 10.** CAN-Merge diff window displaying differences of 2 sub indices

The detail view displays differences of global settings, indices and sub indices. Attributes of indices and sub indices can be modified directly within this view. Modifications have to be confirmed by the button SAVE in the tool bar. A plausibility check is performed when saving these settings.
8. CSV-Import PlugIn

8.1. Usage

With the CVS Import PlugIn objects of the object dictionary can be imported from CSV files. Thus it is possible to export object definitions from other sources (e.g. data bases) as a CSV file and import it into the CANopen Design Tool.

The format of the CSV file can be specified using an *Input Description Specifier*. It allows to select only some columns of a csv file. Additionally, an object offset can be specified for the import.

The CSV Import extension module is an optional PlugIn which is activated by the license file of the CANopen Design Tool. If a valid license is present, CSV Import can be started by the CSV Import menu in the menu bar of the CANopen Design Tool.

![CSV Object Import](image)

*Figure 11, CSV-Import configuration mask*

The following table describes all tokens that can be used for the Input Description Specifier and their value range for the corresponding column in the CSV file. Commas, semicolons or tab stops can be used as separator between the tokens, but only one of them.

<table>
<thead>
<tr>
<th>Element</th>
<th>Value range</th>
</tr>
</thead>
<tbody>
<tr>
<td>index</td>
<td>index in the range between 0x2000 and 0x9FFF</td>
</tr>
<tr>
<td>sub</td>
<td>sub index in the range between 0 and 254</td>
</tr>
<tr>
<td>edname</td>
<td>arbitrary string</td>
</tr>
<tr>
<td>varname</td>
<td>valid C variable name</td>
</tr>
<tr>
<td>access</td>
<td>RO, RW, WO, CONST, RWR, RWW or as lower case letters</td>
</tr>
<tr>
<td>unit</td>
<td>arbitrary string</td>
</tr>
<tr>
<td>min,max,default</td>
<td>numbers using C notation</td>
</tr>
<tr>
<td>datatype</td>
<td>CANopen datatype as decimal number (see object dictionary)</td>
</tr>
<tr>
<td>objectcode</td>
<td>VARIABLE (default), ARRAY or SUB</td>
</tr>
<tr>
<td>desc</td>
<td>arbitrary string only for VARIABLE or ARRAY</td>
</tr>
<tr>
<td>createvar</td>
<td>flag if the c-variable shall be created (0 or 1)</td>
</tr>
<tr>
<td>Element</td>
<td>Value range</td>
</tr>
<tr>
<td>--------------</td>
<td>----------------------------------</td>
</tr>
<tr>
<td>pdomapping</td>
<td>flag if it can be mapped into a PDO (0 or 1)</td>
</tr>
</tbody>
</table>

### 8.2. Examples

This examples shows a standard configuration of manufacturer specific objects.

**Input Description Specifier:**

```
index, sub, varname, edsname, unit, access, min, max, default, datatype, \objectcode, createvar, pdomapping
```

**CSV File:**

```bash
0x3000,0,man_eins,EDSName_1,,ro,0,0xff,0xF0,5,VARIABLE,1,0
0x3001,0,man_zwei,Variable_2,,ro,0,0xff,0xF0,5,VARIABLE,1,0
0x3002,0,man_drei,Ohne_Create_Var,,ro,0,0xff,0xF0,5,VARIABLE,0,1
0x4000,,min_array,Lufthupe1,,rw,,6,ARRAY,0,0
0x4000,1,,Lufthupe1,,wo,0,0xf1,0x01,6,SUB,1,1
0x4000,2,,Lufthupe2,,ro,0,0xf2,0x02,6,SUB,1,1
0x4000,3,,Lufthupe3,,rwr,0,0xf3,0x03,6,SUB,1,1
```

The next example shows how to ignore some columns from the CSV file.

**Input Description Specifier:**

```
;;,;index;;varname;;access;default;datatype;objectcode;edsname
```

**CSV File:**

```bash
whatever;;ign;;0x2001;0;0;test_1;;ro;0;6,VARIABLE;Number of Inputs
whatever;;ign;;0x2002;0;0;test_2;;ro;0;6,VARIABLE;Number of Outputs
whatever;;ign;;0x2003;0;0;test_3;;ro;0;6,VARIABLE;Number of Variables
```
9. Different versions

9.1. Standard version
The standard version provides the functions as described herein.

9.2. Light version
In the light version the number of objects is limited to 15 per line. Using the light version it is not possible to generate output files, if a line consists of more than 15 objects.

9.2.1. Limitations
If the number of objects is below 15, all output files of the CANopen Design Tool are generated. If the limit is exceeded, the ‘Light’ version is only able to generate the library configuration file `cal_conf.h`.

9.2.2. Usage
If no future use of the project files in the standard version of the CANopen Design Tool is intended, only the following masks and input fields have to be completed:

- General Settings
- Hardware Configuration

To configure the CANopen Library according to the used CANopen services the following procedure is recommended:

- Create the desired lines
- In every line the communication segment has to be filled completely.

When the configuration is complete the file `cal_conf.h` can be created by *Generate all Files*. The project file of CANopen Design Tool light has to be saved too, because it is not possible to import the Library configuration from a `cal_conf.h`. The project file can be reused in the standard version of the CANopen Design Tool.
9.3. CANopen EDS Editor

9.3.1. Limitations
The generation of the output files is limited to the XDD/EDS files and the documentation.

9.3.2. Usage
The CANopen EDS Editor is a reduced version of the CANopen Design Tool. Thus it is possible to use project files of the CANopen Design Tool to handle the data of the EDS files. Using the EDS/XDD files directly via "File → Import EDS/XDD file" and "Generate → Generate all files" is also possible.

If no future use of the project files in the standard version of the CANopen Design Tool is intended, only the following masks and input fields have to be completed:

- General EDS/XDD Settings
  - CharacteristicsList
- EDS/XDD Settings (line specific)
- at the structure view of the indices:
  - EDS Name
  - Data Type
  - Object Code
  - Description (only for XDD parameter description and the documentation)
- at the structure view of the sub indices:
  - EDS Name (for arrays and records)
  - Data Type
  - Access
  - PDO Mapping
  - Value
  - Unit (only for the documentation)
10. How to convert existing projects

10.1. Existing projects - Version >= 2.2
Existing projects can be opened straightforward by opening the existing .can file. If there are new settings for the hardware configuration or other important changes that require your action, you will be informed about that when opening an existing project.

10.2. Existing projects - Version >= 2.0
To import existing projects of the versions 2.0 or 2.1 just open the .can-file. Please regard the following issues:

• The "Object Dictionary Optimizations" are not imported.
• If necessary the SYNC objects (1005 etc.) should be deleted and inserted again.
• Please check all hardware settings! The number of options has increased for several hardware platforms and these new options must be configured.
• Once the project file has been saved with this version of the CANopen Design Tool it cannot be opened again with an older version.

10.3. Existing projects - Version < 2.0
Existing projects that can be converted consist of a CANopen Design Tool project from release 1.5 to 1.7.2 and of a cal_conf.h file of the CANopen Library release 4.3. The object dictionary and the EDS settings are extracted from the old CANopen Design Tool project and the hardware and library configuration is taken from the file cal_conf.h.
10.3.1. The project converter

The project converter dtConv.exe (resp. dtConv on Linux) can be used without installation. After the start the mask shown above appears.

When having entered the paths\(^3\) correctly into their entries, the conversion can be started by pressing the ‘Convert’ button. If the path to the current CANopen Design Tool is not correct or if it is not installed, the project cannot be converted.

Before the conversion the profiles of the new CANopen Design Tool are imported and it must be specified which profiles had been used in the existing project.

\[\text{Figure 12 , the project converter}\]

The project converter dtConv.exe (resp. dtConv on Linux) can be used without installation. After the start the mask shown above appears.

When having entered the paths\(^3\) correctly into their entries, the conversion can be started by pressing the ‘Convert’ button. If the path to the current CANopen Design Tool is not correct or if it is not installed, the project cannot be converted.

Before the conversion the profiles of the new CANopen Design Tool are imported and it must be specified which profiles had been used in the existing project.

\[\text{Figure 13 , profile selection dialog}\]

During the conversion a log window is opened where status information, hints and warnings are displayed.

---

\(^3\) The path to an old project is the directory that contains the \textit{line0} directory.
10.3.2. Limitations

10.3.2.1. Segmentation of the Object Dictionary
Information about segmentation of the object dictionary are lost during conversion. Nevertheless the objects within segments are converted properly and the segment information can be added afterwards by the CANopen Design Tool.

10.3.2.2. User-defined data types
Possibly user-defined data types are not converted properly. But each usage of an unknown data type is displayed in the log window and these indices (objects) can be reworked afterwards.
Please consider that the concept of the usage of user defined data types has been changed compared to former releases of the CANopen Design Tool. (Have a look into section Manufacturer Structures in chapter 5)
Moreover it is highly recommended to check all converted settings properly.

10.4. Conversion support
Please contact us, if there are any problems or irregularities at the conversion.
Appendix 1 — Abbreviations

CAN  Controller Area Network
CAL  CAN Application Layer (CANopen base)
CiA  CAN in Automation international users and manufacturers group e.V.
COB  Communication Object (CAN Message)
COB-ID Communication Object Identifier
DDE  Device Description Entry
EMCY Emergency Object
EPL  Ethernet POWERLINK
EP SG Ethernet POWERLINK Standardization Group
ESI  EtherCAT Slave Information
      XML device description for EtherCAT slaves
ETG  EtherCAT Technology Group
NMT  Network Management
PDO  Process Data Objects, they are messages in a unconfirmed service.
      They are used for the transfer of real-time data to and from the device.
RPDO Receive PDO
SDO  Service Data Objects, they are messages in a confirmed service.
      They are used for the access to entries of the object dictionary.
CS DO Client SDO
SS DO Server SDO
SYNC Synchronization Object
TIME Time Stamp Object
TPDO Transmit PDO
XDD  XML Device Description - device description files for POWERLINK
      or CANopen
XML  eXtensible Markup Language